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The purpose of this document is to provide you with an overview of the possibilities
offered by SAP ERP Knowledge Modules and how to use them in Oracle Data
Integrator.

This document provides examples to help you understand how to achieve an ETL
project with Oracle Data Integrator, loading a Data Warehouse with data from SAP
systems, while validating data quality.

This project should take approximately 90 minutes to complete. You may save your
work in order to pause and resume at any point in the project.

It is recommended that you use Oracle Data Integrator before proceeding with this
guide. A good introduction to Oracle Data Integrator is the guide .

It is recommended that you also review the SAP ABAP chapter of the Developing
Knowledge Modules with Oracle Data Integrator for more information about the SAP ERP
KMs.
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Overview of Oracle Data Integrator SAP

ERP Knowledge Modules

This chapter provides an overview of Oracle Data Integrator SAP ERP Knowledge
Modules.

This chapter includes the following sections:

1.1 Overview

Overview

Overview

The Oracle Data Integrator SAP ABAP Knowledge Modules provide integration from
SAP ERP systems using SAP JCo libraries. This set of KMs has the following features:

Reads SAP data from SAP ERP system
Loads this SAP data into Oracle or non-Oracle Staging Area

Reverse-engineers SAP metadata and proposes a tree browser to pick up only the
required metadata

This adapter includes three knowledge modules:

RKM SAP ERP: Its main role is to perform customized reverse-engineering of SAP
tables into ODI datastores (Models). The SAP ERP RKM is in charge of connecting
to the SAP System, which provides the SAP table's metadata information, and
transforming and writing the resulting metadata into Oracle Data Integrator's
repository.

The LKM SAP ERP to Oracle (SQLLDR) connects to SAP and retrieves data from
the SAP tables defined in the SAP Model. It is used in the mappings. The LKM is in
charge of loading source data from a SAP System to an Oracle staging area.

The LKM SAP ERP to SQL connects to SAP and retrieves data from the SAP tables
defined in the SAP Model. It is used in the mappings. The LKM is in charge of
loading source data from a SAP System to a non-Oracle staging area.

Overview of Oracle Data Integrator SAP ERP Knowledge Modules 1-1
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Setting Up the Environment

This chapter describes how to set up your SAP ERP environment for use with Oracle
Data Integrator.

This chapter includes the following sections:
¢ Before You Begin
* Validating the Shared Folder Setup
¢ Validating the FIP Setup
* Validating SAP Privileges
¢ Validating SAP Transport Layer Name
¢ Installing Oracle Data Integrator
¢ Installing and Configuring the Oracle DB Target
¢ Installing and Configuring JCo
¢ Configuring Oracle Data Integrator
Before You Begin
Validating the Shared Folder Setup
Validating the FTP Setup
Validating SAP Privileges
Validating SAP Transport Layer Name
Installing Oracle Data Integrator
Installing and Configuring the Oracle DB Target
Installing and Configuring JCo

Configuring Oracle Data Integrator

2.1 Before You Begin

Before you begin, consider the following:
* System Requirements and Certification
* Getting the Right Privileges

* Gathering SAP Connection Information

Setting Up the Environment 2-1
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* Requesting FTP Server Access

System Requirements and Certification
Getting the Right Privileges
Gathering SAP Connection Information

Requesting FTP Server Access

2.1.1 System Requirements and Certification

Before performing any installation you should read the system requirements and
certification documentation to ensure that your environment meets the minimum
installation requirements for the products you are installing.

The Oracle Data Integrator requirements are listed in the Installing and Configuring
Oracle Data Integrator.

The requirements specific to the Oracle Data Integrator SAP ABAP Adapter are:

® Oracle Data Integrator 11.1.1.7.0 or above.

Note:

Most of this documentation also applies to the SAP connectivity in Oracle BI-
Applications, which requires Oracle Data Integrator 10g, as specified in more
detail in System Requirements and Supported Platforms for Oracle Business
Intelligence Applications for SAP.

¢ A Java Connector (JCo) version compatible with adapter must be used. The list of
supported JCo versions is available in the Certification Matrix available from
Oracle Technology Network (OTN). A minimum version of JCo 3.0.2 is required.

¢ A JVM version compatible with both Oracle Data Integrator and JCo must be used.
A minimum version of JVM 1.5 is required due to JCo pre-requisites.

* The connector supports two transfer modes for transferring data from SAP system
to the ODI agent: data transfer using a Shared Directory and data transfer through
FTP. For details and restrictions see "File Transfer Considerations" of Application
Adapters Guide for Oracle Data Integrator. Depending on the chosen file transfer
mode the following requirements must be met:

— Data transfer through a Shared Directory (recommended transfer method)
The LKM SAP ERP to Oracle (SQLLDR) requires a folder that is shared between
the SAP system and the ODI agent. The SAP application server transfers the
data by writing it out into a folder that is accessible from the SAP system and
the ODI agent machine. This is typically done by sharing a folder of the ODI
agent machine with the SAP system. Note that the shared folder does not
necessarily have to be located on the ODI agent machine. A shared folder on a
third machine is also possible, as long as the shared folder is accessible to both
the ODI agent machine and the SAP system.

2-2 Getting Started with SAP ABAP ERP Adapter for Oracle Data Integrator
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Note:

For security reasons, the SAP folders should not be shared with the ODI agent.
Share only folders of the ODI agent machine with the SAP system.

The shared folder must be accessible to SAP system and not just to the
underlying operating system. This means that the folder needs to be declared in
SAP transaction AL11 and the folder opens successfully in AL11.

— Data transfer through FTP LKM SAP ERP to Oracle (SQLLDR) requires a FTP
server to upload data from the SAP ERP system. This data is either read locally
by the agent executing the mapping (when this agent runs on the FTP server
machine), or remotely (when this agent is located on a different machine than
the FTP server). This FTP server must be accessible over the network from both
the SAP ERP machine and the agent machine.

For LKM SAP ERP to Oracle (SQLLDR) only: SQL*Loader is required on the
machine running the agent the executed mappings using LKM SAP ERP to Oracle
(SQLLDR). SQL*Loader is used for loading data extracted from SAP to the Oracle
staging area.

2.1.2 Getting the Right Privileges

The SAP Adapter requires privileges to perform set up and execution operations.
Please provide your administrators with the list of privileges listed in SAP ABAP ERP
Required Privileges. These privileges are required for the SAP user that they will
provide you to login the SAP System.

2.1.3 Gathering SAP Connection Information

In order to connect to the SAP ERP system, you must request the following
information from your SAP administrators:

SAP ERP System IP Address or Hostname: IP address/ Hostname is the technical
name given to the host on which SAP is running.

SAP User: SAP User is the unique user name given to a user for logging on the SAP
System.

SAP Password: Case-sensitive password used by the user to log in.

SAP Language: Code of the language used when logging in For example: EN for
English, DE for German.

SAP Client Number: The three-digit number assigned to the self-contained unit
which is called Client in SAP. A Client can be a training, development, testing or
production client or represent different divisions in a large company.

SAP System Number: The two-digit number assigned to a SAP instance which is
also called Web Application Server or WAS.

SAP System ID: The three-character, unique identifier of a SAP system in a
landscape.

SAP Transport Layer Name: This string uniquely identifies a transport layer in a
SAP landscape. It allows ODI to create transport requests for later deployment in
SAP. Even though there is a default value here, this transport layer name must be
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provided by your SAP Basis team. Not doing so may result in significant delays
during installation.

® SAP Version: The version of the SAP system.

* SAP Character Set: The character set is only required if your SAP system is not a
UNICODE system. For a complete list of character sets, see "Locale Data" in the
Oracle Database Globalization Support Guide. For example, EE8] SO8859P2 for
Croatian Data. For UNICODE systems, use UTF8.

Note:

All the connection data listed above (except SAP SNC Connection Properties
and SAP Router String) are mandatory and should be requested from the SAP
Administrators. You may consider requesting support during connection
setup from your SAP administrators.

2.1.4 Requesting FTP Server Access

This section applies only if you plan to transfer data using FTP. You can skip this
section if you use a Shared Directory for the data transfer or if your SAP system is
older than the following;:

e SAP ECC6 EHP6 or later

e SAP BW/BI 7.4 or later

The following steps must be performed before any subsequent steps in this guide can
be performed. These steps are typically performed by your SAP Basis team. Failure to
perform these setup instructions will lead to FTP failure when running any ODI SAP
extraction jobs.

To request FTP server access:
1. Login to SAP server.

2. Execute transaction SE16.

3. Enter SAPFTP_SERVERS in the Table Name field and click [ icon to create
entries.

4. Enter IP address of the FTP server in the FTP_SERVER_NAME field.

5. Enter port of the FTP server in the FTP_Server_Port field.

|
6. Click icon to save.

2.2 Validating the Shared Folder Setup

Validating a shared folder setup applies only if you plan to transfer data using a
Shared Directory. This section can be skipped, if the FTP transfer is used. The
validation of the shared folder setup needs to be performed before any subsequent
steps in this guide can be performed. This validation is typically performed by your
SAP Basis team.
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Step 1: Validating folder access from the SAP application server

1. Start the SAPGUL

2. Use the ODI SAP user and password to connect to the SAP system and client.
3. Go to transaction AL11.

4. Select the shared folder.

5. Double-click the shared folder to test the directory declaration.

This should report a successful connection. If not, please contact your SAP basis
team. Do not continue until this test passes.

Note:

SAP uses the OS user <sid>adm to connect to the directories declared in AL11.

6. Print screen.

Step 2: Validating folder access from the ODI agent machine

1. Log in to the ODI agent machine using the Windows user ID used for executing the
ODI agent.

2. Open shared directory path in Windows Explorer.

This should list the content of the shared folder. Please make sure that you do NOT
need to enter any credentials. If this does not work or you had to enter credentials,
please contact your windows administrator or the system administrator of the
system your shared folder is physically located on. Do not continue until this test
passes.

3. Print screen.

2.3 Validating the FTP Setup

Validating an FTP setup applies only, if you plan to transfer data using FTP. This
section can be skipped, if you use a Shared Directory for the data transfer. The
validation of the FTP setup needs to be performed before any subsequent steps in this
guide can be performed. This validation is typically performed by your SAP Basis
team.

Step 1: Validating SAPFTPA destination

1. Start the SAPGUI

2. Use the ODI SAP user and password to connect to the SAP system and client.
3. Go to transaction SM59.

4. Expand TCP/IP connections.

5. Open the SAPFTPA destination.

6. Click Test connection.
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7.

This should report a successful connection. If not, please contact your SAP basis
team. Do not continue until this test passes.

Print screen.

Step 2: Testing FTP connection

. Go to transaction SE38.

View the function module RSFTP002.

Hit F8 to run the ABAP program.

Enter the FTP userID and password.

Enter the FTP server host name or IP address.
Entercd / orcd <ODI target directory>.
In the RFC_DESTINATION field, enter SAPFTPA.
Hit F8 to run the test.

This should report a successful connection. The message should be similar to the
following;:

250 CWD successful .

If this test is not successful, please contact your SAP basis team. Do not continue
until this test passes.

Print screen.

2.4 Validating SAP Privileges

This section describes how to test some of the key SAP privileges. Proceed with the
subsequent steps in this guide only after successful validation of these tests. This
validation is typically performed by your SAP Basis team.

Perform the following steps to validate whether a SAP user has appropriate dev rights
and owns a dev license key:

1.

2.

5.

6.

Start SAPGUL
Use the ODI SAP user and password to connect to the SAP system and client.

Go to transaction SE38.

. Enter any sample program name like ZSAP_TEST in the program name field.

Click Create.

Perform similar tests for the transaction SE37 and SE11.

If a transaction allows the creation of a program without asking for any key or other
authorization message, then the SAP user has validated that it has the appropriate dev
rights and license key. Otherwise your SAP basis team needs to register the SAP user
in service.sap.com to get the license key and a Basis person can help him with dev
rights.
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Validating SAP Transport Layer Name

2.5 Validating SAP Transport Layer Name

As the SAP connector creates SAP objects, such as, for example, function modules, into
the SAP development system, these changes need to be transported into QA and
production systems once the development is done. The SAP's change and transport
system uses the SAP Transport Layer Name to identify the route a change has to take. A
transport layer is assigned to each development class and thus to all objects in that
class. The transport layer determines:

¢ In which SAP System developments or changes to the repository objects are made

e If objects are transported to other systems within the group when development
work has been completed

A consolidation route is created from the development system to the quality assurance
system through thet ransport | ayer Z<SI| D>. It then becomes the standard
transport layer for customer development and customizing.

A consolidation route is created from the development system to the quality assurance
system through the t ransport | ayer SAP for the transport of SAP Standard
objects.

It is important to specify the correct transport layer name before running the RKM
SAP ERP for the first time. Perform the following steps to identify the list of defined
transport layers in your SAP landscape:

1. Logonin client 000 in the SAP System serving as the transport domain controller
via transaction STMS.

2. Select Overview > Transport Routes. The Display Transport Routes dialog is
displayed.

3. Select Goto > Graphical Editor.
4. To switch the mode, select Configuration > Display <-> Change.
5. Position the cursor on the SAP System.

6. Select Edit > System > Change. The Change System Attriburtes dialog is
displayed.

7. Select the StandardTransport Layer tab.
8. Change the transport layer of the SAP System.

9. The result is the list of the different transport Layers.

By default, the RKM option SAP_TRANSPORT_LAYER_NAME is set to SAP. Ask
your SAP basis admin which transport layer you should use. This transport layer
name must be set on the SAP_TRANSPORT_LAYER_NAME RKM option. A wrong or
invalid transport layer name will cause serious delays during the installation process.

2.6 Installing Oracle Data Integrator

Before starting with this project, you need to install and configure Oracle Data
Integrator. See the and the Installing and Configuring Oracle Data Integrator for more
information.
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2.7 Installing and Configuring the Oracle DB Target

This project uses an Oracle database engine as the target and as the staging area for the
mappings. You can download for example Oracle Database 11g Express Edition from
Oracle Technology Network (OTN). Install and configure this database.

This project targets an Oracle table that can be created using the following script:

- Create denp target schema

CREATE USER DI _SAP_DEMO | DENTI FI ED BY ODI _SAP_DEMO DEFAULT TABLESPACE USERS
TEMPORARY TABLESPACE TEMP;

GRANT CONNECT, RESOURCE TO ODI_SAP_DEMD

- Create denp target table
CREATE TABLE ODI _SAP_DEMO. W GEO DS (
LANGUAGE_KEY CHAR(20),
COUNTRY VARCHAR(50)
COUNTY VARCHAR(50)
STATE_PROV VARCHAR( 50),
NATI ONALI TY VARCHAR(50) ) ;

ALTER TABLE ODI _SAP_DEMD. W GEO DS ADD CONSTRAINT PK_W GEO DS PRI MARY KEY
( LANGUAGE_KEY) ;

2.8 Installing and Configuring JCo

The SAP adapter uses Java Connector (JCo) to connect to the SAP system. JCo must be
configured before proceeding with the project.

To install and configure JCo:

1. Download a supported JCo version for your configuration from http://
service.sap.com/connectors. Check the supported JCo version in the Certification
Matrix available at Oracle Technology Network. Note that a minimum version of
JCo 3.0.2 is required.

Note:

® Choose the SAP JCo package matching your operating system and your
system architecture (32/64Bit). E.g. if you are running ODI inside a 32-Bit
JVM, you must download the 32-Bit SAP JCo, even if the CPU and OS are
64-Bit. Mixing 32-bit and 64-bit architecture is not possible due to native
libraries required by SAP JCo and will result in connection failure.

¢ odi.conf contains the JDK path used for ODI Studio.

2. Unzip the appropriate distribution package into an arbitrary directory <sapj co-
i nstall -path>.

3. Follow the installation instructions in <sapj co-i nst al | - pat h>/ j avadoc/
instal | ation. htn for the respective platform.

4. Copy sapj co3. j ar and sapj co3.dl | :

For ODI 10g: Copy sapj co3. j ar and sapj co3. dl | (or respective binary like
| i bsapj co3. so) into the or acl edi / dri ver s directory.

2-8 Getting Started with SAP ABAP ERP Adapter for Oracle Data Integrator
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5.

6.

For ODI 11g: Copy sapj c03. j ar and sapj co3. dl | (or respective binary like
| i bsapj co3. so) into the <ODI _HOVE>/ odi _mi sc directory (ODI Studio) and
into the <CDI _HOME>/ or acl edi / agent / dri ver s directory (Standalone
Agent) and into the <WLS_DOMAIN>/lib directory (JEE Agent).

For ODI 12c: Copy sapj c03. j ar and sapj co3. dl | (or respective binary like
| i bsapj co3. so) into the <ODI _HOVE>/ odi / sdk/ | i b directory (ODI Studio,
ODI Standalone Agent) and into the <WLS_DOMAIN>/lib directory (JEE Agent).

Restart ODI Studio and any agents.

Check the JCo installation. This will be also checked later in this guide.

2.9 Configuring Oracle Data Integrator

Perform the following steps to configure Oracle Data Integrator:

1.

Add the Open Tool

Add the Open Tool

2.9.1 Add the Open Tool

The complete process of installing and adding an Open Tool to ODI is described in
Oracle Data Integrator Tools Reference. This section details only the SAP ABAP specific

steps.

1. Connect to Designer.

2. Select File > Add/Remove Open Tools...

3. Inthe Add/remove Open Tools window, enter the following name in the Open
Tool class name field:
oracl e. odi . sap. km _Qdi SapAbapExecut eSt oppabl e

4. Click Add Open Tool.

5. The Add Open Tools window appears as shown below.
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P Y Y e T B e e s

ﬁ., Add ﬁpiﬁ Tools
To add an OpenTool, please add vour OpenTool's JAR or ZIP Files to ' <ide.user.dir >Joracledijuseriib’ f
Data Integrator. Please find <ide.user.dir> property in Properties tab of Help|About section.

% _DdiSAPAbapExecute "-UPLDAD=<upload option>" "-EXECUTE=<execute optic
This Open Tool will upload an ABAP program and also Extracts the data from SAP Systems.,

To delete this Open Tool, click Delete,

Help

6. Click OK.
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Configuring the Topology

This chapter describes how to configure the topology by using a practical example.
This project will integrate the following source and target data:

Source tables TO05T and TO05U are the tables from SAP containing geographical
information.

Target W_GEO_DS is a dimension table in an Oracle database that needs to be loaded
from the SAP Sources. This table contains geographical information such as
Conti nent nane,Country nane, Regi on, State, County,City and Zi p code.

This chapter includes the following sections:

¢ Configuring the File Server for SAP ABAP

* Configuring the Target Data Server

¢ Configuring the SAP Source Server
Configuring the File Server for SAP ABAP
Configuring the Target Data Server

Configuring the SAP Source Server

3.1 Configuring the File Server for SAP ABAP

Perform the following operations after installing or upgrading your Oracle Data
Integrator version:

1. Connect to Topology Manager.

2. If this SAP ABAP technology does not exist in your Master Repository, import the
SAP ABAP technology in Synonym INSERT_UPDATE mode from the / i npexp
folder.

3. Perform an upgrade of the Master Repository. Refer to the Installing and
Configuring Oracle Data Integrator for more information on the Master Repository
upgrade process.

4. In Topology Manager, open the JavaBeanShell technology and check on the
Language tab that the JYTHON language is listed. If not, add it.

5. Create a File data server pointing to an existing FTP/file server into which the
extraction file will be pushed from SAP and picked up for SQL*Loader. For use
with FTP transfer, set the following parameters. For use with shared folder
transfer, the settings on this data server do not matter.

e Host (Data Server): FTP server IP host name or IP address.
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e User: Username to log into FTP server.
e Password: Password for the user.

6. For use with "LKM SAP ERP to SQL" these additional parameters must be
configured:

¢ JDBC driver class: com.sunopsis.jdbc.driver.file.FileDriver

e JDBC URL: jdbc:snps:dbfile?ENCODING=UTF8

The above URL is for SAP UNICODE systems. For non-UNICODE systems,
please see details on ENCODING parameter in "Creating a File Data Server" of
Connectivity and Knowledge Modules Guide for Oracle Data Integrator Developer's
Guide. The encoding chosen on this URL must match the code page used by the
SAP Application Server.

7. In this File data server create a Physical Schema representing the folder in the File
server to which the extraction file will be pushed. For use with FTP transfer, see
details below. For use with shared folder transfer and for more details, see
"Transfer using a Shared Directory (recommended)" of Application Adapters Guide
for Oracle Data Integrator.

* Data Schema: Path on the FIP server to upload or download extraction files
from the remote location. This path is used when uploading extraction files
from the SAP ERP system into the FTP server. It is also used by a remote agent
to download the extraction files. Note that this path must use slashes and must
end with a slash character.

* Work Schema: Local path on the FTP server's machine. This path is used by an
agent installed on this machine to access the extraction files without passing
via the FTP server. This access method is used if the
FTP_TRANSFER_METHOD parameter of the LKM SAP ERP to Oracle
(SQLLDR)/ LKM SAP ERP to SQL is set to NONE. As Work Schema is an OS
file name, slashes/ backslashes should be used according to OS.

Path names need to end on slash/ backslash. Path names given on Data and
Work schemas are not necessarily the same: the FTP service may provide
access to a FTP directory named / sapf i | es while the files can be stored
locally in c: \'i net pub\ ft proot\ sapfil es.

Refer to "File Transfer Considerations” of Application Adapters Guide for Oracle Data
Integrator.

8. If the corresponding Logical Schema called Fi | e Server for SAP ABAP does
not exist yet, create it. This Logical Schema name is fixed and must be mapped to
the Physical Schema created in the previous step.

3.2 Configuring the Target Data Server

This section describes how to setup an Oracle Data Server. Please use respective
settings when configuring a non-Oracle Target Data Server for use with LKM SAP
ERP to SQL.

1. Connect to Topology Manager.

2. In the Physical Architecture tree view, expand the Technologies node and select
the Or acl e technology.
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3.

4.

5.

10.

11.

12.

Right-click and select New Data Server.

Enter the data server Definition as shown below:

™) ORACLE_TARGET

Test Connection

Definition

JDEC

On ConneckfDisconnect
Properties

Dakasources

Wersion

Privileges

Flexfiglds

™ Data Server

Marne: |OR.|5.CLE_T.C'.RGET

Technology:

Instance [ dblink {Data Server): |><E

Connection

User: |DDI_SP.P_DEI"-’IO

Password;

[ ] DI Connection

Array Fekch Size:

Batch Update Size:

Select the JDBC tab, and enter the JDBC connection information to your data

server as shown below:

™) ORACLE TARGET
Test Connection
Definition
JDBC
Cn ConneckfDisconneck

Properties

Datasources

1DEC Driver: |oracle.jdbe.OracleDriver

jdbcioracle:thin@localhosk: 1521 5E
JDEC Url:

Make sure to change the URL to match your Oracle instance configuration.

Click Test Connection to test the connection to this data server.

From File menu, click Save.

Right-click the data server you created and select New Physical Schema.

In the Physical Schema windows that appears, select the ODI _SAP_DEMOfor both
Schema and Work Schema.

If you already have a Work Schema for ODI defined for this data server, you can
use it instead of the ODI _SAP_DEMOSchema.

Go to the Context tab.

Click Add and enter in the Logical Schema field the value ODI _SAP_DEMO.

From the File menu, click Save.
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3.3 Configuring the SAP Source Server
The following topics describe how to configure the SAP source server:
¢ Configuring the Data Server
¢ Configuring the Logical Schema
Configuring the Data Server

Configuring the Logical Schema

3.3.1 Configuring the Data Server

Except for the data server name, all the parameters that you provide while defining
the SAP Data server should be provided by the SAP Administrators. See “Getting the
Right Privileges” for more information.

The SAP Adapter requires privileges to perform set up and execution operations.
Please provide your administrators with the list of privileges listed in SAP ABAP ERP
Required Privileges. These privileges are required for the SAP user that they will
provide you to login the SAP System.

See “Gathering SAP Connection Information” for more information about these
parameters.

1. In the Physical Architecture tree view, expand the Technologies node, select the
SAP ABAP technology.

2. Right-click and select New Data Server.
3. Enter the data server definition. Set the parameters for this data server as follows:
* Name: SAP_ERP. The name of the data server as it will appear in ODL
* Host (Data Server): SAP ERP System IP Address or Hostname.
e User: SAP User, as provided by the SAP Administrator.
¢ Password: This user's SAP Password. This password is case-sensitive.
4.  Set the Flexfield values for this data server in the Flexfields tab:

¢ SAP Language: Code of the language used when logging in. For example EN
for English, DE for German.

* SAP Client Number: The three-digit number assigned to the self-contained
unit which is called Client in SAP. A Client can be a training, development,
testing or production client or represent different divisions in a large company.

* SAP System Number: The two-digit number assigned to a SAP instance which
is also called Web Application Server or WAS.

* SAP System ID: The three-character, unique identifier of a SAP system in a
landscape.

* SAP Character Set: The character set is only required if your SAP system is not
a UNICODE system. For a complete list of character sets, see "Locale Data" in
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the Oracle Database Globalization Support Guide. For example,
EE8I SCB8859P2 for Croatian Data. For UNICODE systems, use UTF8.

Note:

This FlexField is only used with "LKM SAP BW to Oracle (SQLLDR)". For use
with "LKM SAP BW to SQL" please define the character set using the
ENCODING parameter in the file driver URL, as described in “Configuring
the File Server for SAP ABAP” for non-UNICODE SAP systems.

e SAP ABAP Version: Enter the SAP ABAP version as follows:
— For SAP 4.6C enter 46C
— For SAP 4.7 enter 620
— For SAP ECC 5.0 enter 640
— For SAP ECC 6.0 enter 700
e SAP BW Version & SAP ERP Version: unused in SAP ERP Connector.

5. From the File menu, click Save.

Note:

The Test Connection button for validating SAP Connection definition is not
supported for this connection.

3.3.2 Configuring the Logical Schema
1. In the Physical Schema window, do not edit the Definition tab.

2. Select the Context tab, click Add and enter the Logical Schema name
LOd CAL_SAP_ERP.

% sap_ERP_Default

Definition
Context
Versian Conkext Logical Schema
HE: Derveloprent OGICAL SAP_ERP
Privileges
Flexfields

3. From the File menu, click Save.
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Creating a New Project

This chapter describes how to create a new Project for SAP.

In order to work with the data servers you have created, you must create a project and
import the appropriate knowledge modules for reverse-engineering the data
structures and integrating the data.

Creating a New Project

4.1 Creating a New Project

To create a new Project for SAP:

1. Connect to Designer.

2. In the Projects tree view click New Project.

3. In the Definition tab, enter SAP Denp for the Project name.

4. From the File menu, click Save to save your project.

5. Expand the SAP Deno Project, select the Fi r st Fol der node.
6. Rename this folder to SDE_SAP_GeoDi nensi on.

7. Right-click the SAP Denp Pr oj ect in the Projects tree view.
8. Right-click and select Import > Import Knowledge Modules.

9. Select in the File import directory the directory containing your KMs. By default,
they are located in the . . / i mpexp directory.

10. Select the following KMs:

* KM Oracle Incremental Update

LKM SAP ERP to Oracle (SQLLDR)

LKM SAP ERP to SQL
e RKM SAP ERP

RKM SAP ERP Connection Test

11. Click OK to perform the import.
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Reverse-Engineering Data Models

This chapter describes how to reverse-engineer the Oracle target and SAP source data
models.

This chapter includes the following sections:

* Reverse-Engineering the Oracle Target

¢ Reverse-Engineering the SAP Source Datastores
Reverse-Engineering the Oracle Target

Reverse-Engineering the SAP Source Datastores

5.1 Reverse-Engineering the Oracle Target

To reverse-engineer the Oracle data model:

1. Connect to Designer.
2. In the Models tree view, click New Model.

3. In the Definition tab, enter the model parameters as shown below:

|z Cracle Target
@ Reverse Enginesr | % Generate and deploy

Definition

5 Model
Reverse Enginesr

Control Mame: ZIZ'r-En:IEe Target
fotendlzig Code: [ORACLE_TARGET
Journalized Tables
Services Technalogy: | Oracls
Markers Logical Schema: |0DI_S.C'.F'_DEMO
Merna

. Ackion Group: | <iaeneric Ackion>
Version
Privileges Default Folder: |
Flexfields

De=scription:

4. In the Reverse Engineer tab, select the Global context.

Reverse-Engineering Data Models 5-1



Reverse-Engineering the SAP Source Datastores

|z Orade Targst
[B] reverse Enginesr o

Deefimition

Reverse Engineer
Selective Reverse-Engineering
Conkrol

Journalizing
Journalized Tables
Services

Markers

Memo

Version

Privileges

Flexfields

Generate and deploy

(@) Gtandard () Customized

Conkexk: | Global

Logical Agent: |L-:u:a| (Mo Agent)

Types of objects to reverse-engineer

Table Cuueue [ | Swskem Table

Wiem

[] Table Alias

[]aw

Mask: %

Characters ko Remove from Table Alias; |"."u'

Table Alias maximum length: |35

5. Click Reverse Engineer, and then save your model.

6. The WS_GEQO_DS datastore appears in your Oracle model, as shown below.

= Madels

% Diagrams
% Higrarchy
. GTF'.RGET_II"-.ITER"."P.L_HIERARCH\"

[ ] W _ACCNT_YENDR_DS
- W_GED_DS

i ~

D TARGET _MAYIGATIONAL _ATTRIBUTE

5.2 Reverse-Engineering the SAP Source Datastores

To reverse-engineer the SAP Source datastores you need to perform the following

tasks:

1. Creating the Data Model

2. Validating the SAP Connection

3. Starting the Reverse-Engineering Process

This section also includes the following topics:

* Using the SAP Metadata Browser

¢ Reverse-Engineering Without GUI

Creating the Data Model

Validating the SAP Connection

Starting the Reverse-Engineering Process
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Using the SAP Metadata Browser

Reverse-Engineering Without GUI

5.2.1 Creating the Data Model

1.

2.

In the Models tree view, click New Model.

In the Definition tab, enter the model parameters as shown below. You must select
the SAP ABAP technology and the Logical Schema previously created (in our
example it is the LOG CAL_SAP_ERP Logi cal Schem).

|z 5AP ERP SOURCE

fﬁ Reverse Engineer | % Generate and deploy

Definition

Reverse Engineesr

Conkral

Journalizing

Journalized Tables

Services
Markers
Memao
Version
Privileges

FlexFiglds

3.

4.

Model

Marne: =-F'.F' ERF SOLRCE
Code: |SAF‘_ERP_SOLIRCE
Technology: | SAP ABAP

Logical Schema: |LOGICAL_SAP_ERP

Action Group: | <Generic Ackion =

Default Falder; |

Description:

In the Reverse Engineer tab:

a. Select the d obal context.
b. Select Cust omi zed option.

c. Selectthe RKM SAP ERP Connection Test you have imported in the SAP
ERP Deno project.

5.2.2 Validating the SAP Connection

1.

2.

In the Models tree view, open the SAP ERP Sour ce Model.

Click Reverse Engineer and confirm the start of the reverse-engineering process.
This process runs two tests:

¢ Establish a test connection to the SAP system and
¢ Validate the proper setup of SAP JCo by displaying the About dialog.

In a few seconds, you should see the SAP JCo-About dialog as shown here:
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SAP Java Connector (JCo)
Copyright (c) 2000-2007 SAP AG. All rights reserved
Java Runtime
Operating System: Windows XP 5.1 for xB6

Java ViM:

Java Codepage:

Versions
JCo APL:

JCo middleware name: BEEFEIR
JCo middleware: 2.1.1
JCo middieware native:  EREEEE!

Paths

JCo classes;

JCa library,

SAP Java Connector (JCo) n

C
I

THE BEST-RUN E-BUSINESSES RUN SAP E’

1.6.0_14 Sun Microsystems Inc
Cp1252

3.0.2{2009-03-29)

CProgram®20Files\Oracletoraciedi_101351\oracieditdriversisapjcod.jar

C\Program Files\Oracle\oracledi_10135Noracledidriversisapjco3.dil

[ ciose |

Please verify the JCo version number (see “System Requirements and
Certification” for more details) and verify that a path for the JCo Library is given
(. dI'l for Windows). If this is not the case or you see any error message in this
about dialog, please review the SAP JCo installation, as described in your SAP JCo
package, and run this test again.

Note:

Closing the JCo-About-Dialog will also close ODL

Once you have validated SAP JCo installation, open ODI Operator.
In the Operator, expand the Reverse-Engineering session down to the task level.

Verify whether the task "Test SAP Connection" has been executed successfully. If
not, view the task details to identify the connection problem. The output of this
task must contain Successful |y connected to SAP Syst em If not, the
connection test has failed and the connection problem must be analyzed before you
continue.

Do not continue until you have successfully validated the SAP connection!
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Note:

If you want to validate the SAP connectivity independent of OD], please see
SAP Stand-Alone Connection Test.

5.2.3 Starting the Reverse-Engineering Process

To start the reverse-engineering process of the SAP ERP datastores:

1. Inthe Models tree view, open the SAP ERP Sour ce Model.

2. Inthe Reverse Engineer tab:

3. a

b.

Select the G obal context.

Select the Cust om zed option.

Select the RKM SAP ERP you have imported in the SAP ERP Deno project.
Set the USE_GUI KMoption to Yes.

For first time RKM use only: Set SAP_TRANSPORT_LAYER_NANME to the name
of the transport layer your SAP basis admin has provided you with.

Caution:

¢ Pay particular attention to provide the correct value for the
SAP_TRANSPORT_LAYER _NAME option. If an invalid value is used during
the first time installation, a significant delay in the connector installation
may be caused.

e For first time RKM use only: If you are using a custom value for KM
options SAP_FUNCTI ON_GROUP_ODI _DEV and
SAP_FUNCTI ON_GROUP_ODI _PROD, these function groups must not exist
prior the first execution of the UPLOAD_ABAP_CCDE and
UPLOAD_ABAP_BASE settotr ue.

¢ For first time RKM use only: If you are using a custom value for KM
options SAP_PACKAGE_NAME_ODI _DEV and
SAP_PACKAGE_NAME_ODI _PROD, these packages must not exist prior the
first execution of the UPLOAD_ABAP_CCDE and UPLCOAD_ABAP_BASE set to
true.

For first time RKM use only: Set UPLOAD_ABAP_CODE and
UPLCAD_ABAP_BASE to t r ue. After the first execution these values must be
set back to false.

Set other parameters according to your SAP configuration. See the Application
Adapters Guide for Oracle Data Integrator for more information on the RKM
options.

4. From the File menu, click Save to save your changes.

5. Click Reverse Engineer to start the reverse-engineering process.
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6. Click OK.

7. The Sessions Started Dialog is displayed.

8. Click OK.

9. Set UPLOAD_ABAP_CODE and UPLOAD_ABAP_BASE back to No.

10. For first time RKM use only: Validate in Operator that the session is now in status
running. If session has failed, please validate settings. Do not move on until all
installation steps have been completed successfully.

5.2.4 Using the SAP Metadata Browser

As you have set the USE_GUI option to Yes, the RKM displays in the SAP Metadata
Browser the SAP objects organized in the tree view as shown below.

Note:

In case that the below dialog does not show up, see ODI Operator and ODI log
messages for details.

Refer to "Log Files," in Application Adapters Guide for Oracle Data Integrator for
more details.
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-Eh AP Metadata Broweser

E==E=n <)

The Tree View
The Search Panel

5.2.4.1 The Tree View

Search
Table Mame: Short Description;
| | e
Application Component: Package:
| . |
Search
|3 SAP Metadata
. _| A (Accounting - General)
i AII (Auko-ID Infraskructure)
| AP (application Platform)
i BC (Basis Components)
I BwW (SAP Business Information YWarehouse)
i CA (Cross-Application Basis Components)
I OO (Contraling)
| OS5 (Customer Service)
3| EC (Enterprise Controlling)
il EHS (Environment, Health and Safety)
il EP {Enterprise Portal)
3 FI (Financial Accounking)
i FIM (Financials)
2 FS (Financial Services)
33 HUG (Product Lifecycle Management (OldT)
2 ICM (Incentive and Commission Management)
2 IM (Investment Management)
i IM (Inkernational Developrment)
24 IS (Industry Specific)
i KM (Knowledge Management)
i LE (Logiskics Execution
5 Lo {Logistics - General)
_| MM (Materials Management)
Zancel Rewverse

The SAP Modules are organized into a tree view. Only the SAP Modules available to
the current user are displayed. By expanding the tree view, you can see SAP tables,
and select those that you want to reverse-engineer.

Note that only the tables selected in the tree view are reverse-engineered.
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-l.ﬁ S0P Metadata Browser

(=[] wS)

Search
Table Mame:
|S.ﬁ.DR3 | -

#pplication Component:

Short Descripkion:

Package:

Search

-] [ sapR12 (Address Mana

= ¥

gement: Reserve table for communications numbers)

Sl S8DR 13 (Address Management: Reserve table For communications numbers)
i S8DR 14 (Address Management: Reserve table For communications numbers)

a5l

a] ]

SADRZ {Address Management:
- (w] SADR3S {Address Management:
- (v] SADR4 {Address Management:
(] SADRS (Address Management:
-] SaDRA (Address Management:
SADRT (Address Management:
Sl S8DRE (Address management:
i S8DRS (Address management:
SADRP {Address Management:

Telephone Mumbers)
Fax Mumbers)
Teletext Mumbers)
Telex Mumbers)

EDI Table)

Mail Figlds)

%400 addresses)
Saft*Swikch numbers)
Personal Data)

-] SAIN (Central Address File: Address where-used lisk)
-] L To0s (countries)

-] TOOSA (Address routines)

-] TOOSE (Mame of address roukines)
-] [l To0sE (County

-] L To0SF (County: Texts)

(v L To0SM (Mame Formats)

- {w] E TOOSO (Mame Format Fields)

- (w] TOOSS {Taxes: Region (Province) Kew)
- (] TOOST {Country Mames)

-] TOOSU (Taxes: Region Key: Texts)

| oy O g O ey IO oy RO oy IO oy RO oy I oy O oy O oy R oy O oy RN oy RO oy RO oy N oy N oy IO oy A oy IO oy Y oy Y oy Y oy Y e

g E TSaC (Communication Methods (Business address Services))
Cancel Reverse
5.2.4.2 The Search Panel

The Search option group allows you search specific objects in the browser, based on:
® Table Name

® Short Description

¢ Application Component

* Package
For the example project, the TOO5T and TOO5U country tables are used:

1. Enter TOO5T in the Table Name field and click Search to find the first table to
reverse-engineer. Select this table.
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2. Enter TOO5Uin the Table Name field and click Search to find the second table to
reverse-engineer. Select this table.

3. Click Reverse.

4. Oracle Data Integrator starts the reverse-engineering process on the selected
datastores. The reverse-engineered datastores appear under the Model.

5.2.5 Reverse-Engineering Without GUI

If you want to perform a reverse-engineering without using the SAP Metadata
Browser, you can enter the following parameters in the SAP ERP KM options:

e USE_GUI No

e SAP_TABLES_NAME : TOO5T, TOO5U

With this configuration, the tables will be reverse-engineered without displaying the
SAP Metadata Browser.

By using the appropriate KM options, you can also select a filter for the reversed tables
based on for example a SAP Module or a Package name. You can also specify a table
name mask in the Mask field of the Reverse tab to filter table names.

Refer to the Application Adapters Guide for Oracle Data Integrator for more information
on the RKM options.

Note:

It is not possible to view the data in the SAP ERP tables from Oracle Data
Integrator.

What happens when you reverse-engineer SAP ERP tables?

First, Oracle Data Integrator uploads in the SAP system ABAP code allowing for
retrieving the SAP metadata. This RFC is uploaded only if the UPLOAD_ABAP_CODE
and UPLOAD_ABAP_BASE options are selected (these options are typically activated
only once). The ABAP programs are generated in the SAP function group given in the
SAP_FUNCTI ON_GROUP_CDI _DEV and SAP_FUNCTI ON_GROUP_ODI _PRODRKM
options.

Once this code is set up on SAP, Oracle Data Integrator is able to retrieve the SAP
metadata and to display it in the SAP Metadata Browser. Selected metadata is then
reverse-engineered from SAP into the Oracle Data Integrator repository. The
repository only contains the description of the SAP metadata, and no data at all.

In addition to the table definitions organized and enriched with user-friendly
information, the keys and indexes definitions are also retrieved. The model appearing
in Oracle Data Integrator shows all the information required for performing
integration tasks on the SAP ERP Model.

Reverse-Engineering Data Models 5-9



Reverse-Engineering the SAP Source Datastores

5-10 Getting Started with SAP ABAP ERP Adapter for Oracle Data Integrator



6

Creating and Running the Mapping

This chapter describes how to create and run the mapping.

This chapter includes the following sections:
* Creating the Mapping
¢ Running the Mapping

Creating the Mapping

Running the Mapping

6.1 Creating the Mapping

Now that the source and target data models are created, it is possible to create a
mapping to integrate data from the TOO5T and TOO5USAP tables to the W5_GEO_DS
Oracle table.

To create the mapping, perform the following steps:
1. Create the Mapping

2. Define the Source and Target Datastores

3. Define Joins between Sources

4. Create the Mappings

5. Define the Mapping Flow

Create the Mapping

Define the Source and Target Datastores
Define Joins between Sources

Create the Mappings

Define the Mapping Flow

6.1.1 Create the Mapping
1. Open Designer.
2. In the Projects tree view, expand the SAP Deno Project.
3. Expand the SDE_SAP_GeoDi nensi on folder.

4.  Select the Mappings node.
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5. Right-click and select New Mapping.

6. In the Mapping Definition tab, enter the mapping name:
SDE_SAP_CeoDi nensi on. W GEO DS.

7. Save the mapping.

6.1.2 Define the Source and Target Datastores

To define the source and target datastores:

e In the Models tree view, select the W5_GEO_DS datastore from the Or acl e
Tar get Model.

® Drag this datastore into the Target Datastore area of the Logical diagram. (Right
area of the Logical diagram)

¢ In the Models tree view, select the TOO5T Country Nanes datastore from the
SAP ERP Sour ce model.

* Drag this datastore into the Sour ces area of the Logical diagram.

® Perform the same operation for the TOO5U Taxes: Regi on Key datastore from
the SAP ERP Sour ce model. The Sources area of the Logical diagram should look
as shown below:

=] Default
L] L *
| TO0ST 3 TO0SU
@=  MANDT b= MANDT
@=  SPRAS b=~ SPRAS
L ] -
@=  LAND1 b~  LAND1
LANDX = BLAND
MATIO BEZF
L L ] L]
LAMDESD
MATICE0
PRG_SPREGT

6.1.3 Define Joins between Sources

To create joins between the source datastores of a mapping:

1. Inthe Sources area of the Logical diagram drag the SPRAS attribute from the
TOO5T Country Name datastore onto the SPRAS attribute in the TOO5U
Taxes: Regi on Key datastore.

2. On the Create Lookup or Join popup, select Join and click OK. This defines the
first join on the Language Key identifier, as shown below:
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(=] Default
TOOST TO0SU

B=  MANDT B  MANDT

B= SPRAS - @~  SPRAS &

@  LANDI L | @~ LANDY
LAND¥ G-  BLAND
NATIO BEZE|
LAND¥50
NATIOSO
PRQ_SPREGT

3. Drag the LANDL attribute from the TOO5T Country Nane datastore onto the
LANDL1 attribute in the TOO5U Taxes: Regi on Key datastore. The join is
extended with the new attributes. In the Properties panel, you can see the join
clause: TOO5T. SPRAS=T005U. SPRAS AND TOO5T. LAND1=T0O5U. LAND1L

4. In the Properties panel, select Generate ANSI Syntax and Join Order options, and
make sure that the Execute on Hint option is set to Source as shown below:

JOIM - Properties

Q, Find
[E Condition
Default.TO0O5T.S5PRAS = Default.TO05U.5PRAS Default.TOOST.LAHD1 = Default
Jnin Condition:
Cross Makural
TOOST{TOOST) [E ] TOOSUTOOSL)
Jain Type:
ik Inner Join

Al rows paired by the join condition between TOOST(TOOST) and TOOSTOOSL)

Technical Description: |

Generate ANSI Synkax:

Jain Order: User Defined: |10

Execute an Hink: | Source

5. Make sure that table number of TO05U is smaller than that of TOO5T. In 1.1
relationships the parent table has to be the first in a join.

6.1.4 Create the Mappings

To create the mappings of the target datastore:

1. Select the LANGUAGE KEY attribute from the target datastore.
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2. Drag the SPRAS attribute from the TOO5T Country Names source datastore
onto the LANGUAGE KEY attribute of the target datastore.

3. Make sure that the Execution on Hint option is set to Source. The mapping
should look as shown below:

New Mapping | CE LANGUAGE KEY - Propetties

Q, Find
=l Target
Default.TOO5T.SPRAS
Expression:
Execute on Hint: |Sn:|urn:e 'l
Fixed Execution Location: | vl

Technical Description: | |

Ea

Repeat this operation to perform the following simple mappings:
e W CGEO DS. COUNTRY = TOO5T. LAND1

e W GEO DS. COUNTY = TOO5T. LANDX

e W CGEO DS. STATE_PROV = T005U. BLAND

e W GEO DS. NATI ONALI TY = TOO5T. NATI O

6.1.5 Define the Mapping Flow
To define the mapping flow:

1. Select the Logical diagram. The Flow diagram looks as shown below;

"1, SOURCE_GROUP

<% LOGICAL_SAP_ERP_UNIT
" TARGET_GROUP

=
| (® ODI_SAP_DEMO_UNIT
TOOST
- =3 =
. 1.‘ l _
> AGED DS
o DEFAULT..  DS_
=
TOOSU
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7.

In the target group, select the access point for the source group that contains both
the TOO5T and TOO5U datastores. This source group represents the source dataset
made up of two joined SAP ERP datastores.

In the Property panel, under Loading Knowledge Module, select LKM SAP ERP
to Oracle (SQLLDR) or LKM SAP ERP to SQL from the Loading Knowledge
Module drop-down list.

a. Ifyou are using FTP for the data transfer, please set the
FTP_TRANSFER_METHOD option to FTP. If the FTP server is installed on
your ODI agent machine, select NONE.

b. Leave other options as they are.

In the target group, select the target Oracle database, which is also used as the
staging area for this mapping.

In Property panel, under Integration Knowledge Module, select | KM Or acl e
I ncremental Updat e from the Integration Knowledge Module drop-down list.

Set the IKM options as follows:
a. Select No for the FLOW_CONTROL option.
b. Leave other options as they are.

From the File menu, click Save and close your mapping.

6.2 Running the Mapping

This section contains the following topics:

® Running the Mapping

¢ Review the Mapping Execution

* Review the Resulting Data

Running the Mapping
Review the Mapping Execution

Review the Resulting Data

6.2.1 Running the Mapping

To run the mapping:

1.

2.

In the Projects tree view, expand the SAP Denp Project
Expand the SDE_SAP_GeoDi nensi on folder.

Expand the Mappings node.

Select the SDE_SAP_GeoDi nmensi on. W GEO_DS mapping.
Right-click and select Execute.

In the Execution window that appears, click OK.
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7. Click OK in the Session Started window.

What happens when you run the mapping?

First, Oracle Data Integrator creates an ABAP program that does the following:

¢ It performs the extraction of the data on the SAP engine. In this example, the
extraction joins the two source tables and then returns the joined resultset in an
extraction file.

e [t uploads the extraction file into a FTP data server. This FTP host is specified via
the File Logical Schema called Fi | e Server for SAP ABAP. This Logical
Schema is mapped to a Physical Schema and therefore a data server in the given
context. This data server contains the connection information for the FTP host.

Then, the ABAP code is uploaded using the OdiSapAbapExecute tool. The ABAP
program is pushed into the SAP Function group given in the SAP_FUNCTI ON_GROUP
LKM option. This phase can be suppressed by setting the UPLOAD_ABAP_CODE LKM
option to No.

The ABAP code is executed also by the OdiSapAbapExecute tool. At the end of the
ABAP code execution, the extraction file is available in the FTP host.

The Oracle Data Integrator agent is able to download this extraction file from the FTP
host, or directly access it, depending on the FTP_TRANSFER_METHOD specified in
the IKM option.

Finally, when the agent accesses the extraction file, it uses SQL*Loader or a JDBC
Connection to load this file into the Oracle/non-Oracle staging area. The rest of the
integration process takes place within the Oracle/non-Oracle engine.

6.2.2 Review the Mapping Execution

To review the mapping execution:

1. Connect to Operator.

2. In the Operator, select the Session List tree view.
3. Expand the All Executions node in this tree view.
4. The latest session is the first entry of this list.

5. Double click the SDE_SAP_GeoDi nensi on. W GEO_DS node to see the session
details and the number of lines processed.

6.2.3 Review the Resulting Data

To review the resulting data:
1. Inthe Designer, in the Models tree view, expand the Or acl e Tar get Model.

2. Select the W GEO_DS datastore, right-click and select Data to view the data
integrated into the target Oracle table.
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Going Further with Oracle Data Integrator

This chapter describes what steps to take next with Oracle Data Integrator.
You have now completed a project extracting data from a SAP ERP system!

In this project, you have:
® Set up the environment and topology to work with SAP ERP.
* Created and reverse-engineered a SAP ERP data model

* Created a mapping to load the data from several joined SAP ERP tables into the
Oracle database.

Note:

In case the execution did not complete successfully, please check the ODI
Operator and ODI Logs for details. In addition to this, the following log files
will contain execution information.

— <System Tenp Dir or local FTP dir>/ ZODl _<Mappi ng
| d> <SrcSet > _<Cont ext >. out

— <System Tenp Dir or local FTP dir>/ ZODl _<Mappi ng
| d>_<SrcSet >_<Context>. err

Refer to "Log Files," in Application Adapters Guide for Oracle Data Integrator for
more details.

Refer to the individual KM options and their descriptions as well as to
"Considerations for SAP ERP Integration" in "Application Adapters Guide for Oracle Data
Integrator” for more information on the SAP ERP KM features and options.

Going further with Oracle Data Integrator

7.1 Going further with Oracle Data Integrator

Use the demonstration environment to familiarize yourself with Oracle Data
Integrator. You can go further with Oracle Data Integrator by taking advantage of the
samples available on the Oracle Technology Network.
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SAP ABAP ERP Required Privileges

This appendix lists the required privileges for accessing the SAP system using Oracle
Data Integrator.

An SAP dialog user is required for connecting to the SAP system, for the RKM
installation and for the LKM execution during development. A SAP RFC user is not
sufficient.

During development, this user must have a developer license key. License keys can be
retrieved from http://service.sap.com. Any execution attempts without this developer
license key will lead to failure and may cause the need for clean-up operations.

For RKM and LKM execution in production, an SAP RFC user is sufficient.

These SAP user types can be used for the following operations:

Table A-1 Required SAP User Types

Operation Required SAP User Type

RKM: Setup SAP Dialog user

RKM: Reverse Engineering SAP Dialog user or SAP RFC user
LKM: Development SAP Dialog user or SAP RFC user
LKM: Production SAP Dialog user or SAP RFC user

The following tables list the privileges required for using SAP ABAP Knowledge
Modules:

e Authorizations Required for RKM SAP ERP Upload
* Authorizations Required for RKM SAP ERP Execution
¢ Authorizations Required for LKM SAP ERP Upload (Background mode)
* Authorizations Required for LKM SAP ERP Execution (Background mode)
e Authorizations Required for LKM SAP ERP Upload (Dialog mode)
* Authorizations Required for LKM SAP ERP Execution (Dialog mode)
Important points to consider
Authorizations Required for RKM SAP ERP Upload
Authorizations Required for RKM SAP ERP Execution
Authorizations Required for LKM SAP ERP Upload (Background mode)
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Important points to consider

Authorizations Required for LKM SAP ERP Execution (Background mode)
Authorizations Required for LKM SAP ERP Upload (Dialog mode)
Authorizations Required for LKM SAP ERP Execution (Dialog mode)

A.1 Important points to consider

Consider the following points while configuring the SAP privileges:

* S_DATASET is an authorization object that controls access to physical file, so you
need to provide access to SAP directories & folder mounted path. The values
provided here are sample paths, you need to provide your landscape directories
path or provide *(all).

e NR or (NR) means NOT REQUIRED.

A.2 Authorizations Required for RKM SAP ERP Upload

The following SAP authorizations are required for first time installation of the RKM
SAP ERP.

Note:

Developer key is required in this authorization.

Object Field Name  Value (4.6¢c) Value (4.7) Value (ECC  Value (ECC
5) 6)
S RFC ACTVT 16
RFC_NAME RFC1, SDI FRUNTI M SDI FRUNTI M
SDI F, E, SDI F(NR) E, SDI F(NR)
SUTL,
SYST,
ZODI _FGR

RFC_TYPE FUGR
S _TCODE TCD SU53, SE38
S ADM _FCD S ADM _FCD MEMO SMD2 (NR) NR
S CTS_ADM CTS_ADMFCT TABL
S DATASET  ACTVI 34
FI LENAME \
\ HYPTESTO1
\ sapmmt
\trans
\actl og

\ <8I D>*

PROGRAM SAPLSLOG, SAPLSLOG
SAPLSTRF

S TABU DI'S ACTVT 03 NR
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Object

Field Name

Value (4.6c)

Value (4.7)

Value (ECC  Value (ECC
5) 6)

S_DEVELOP

S_TRANSPRT

DI CBERCLS
ACTVI

DEVCLAS

OBJINANMVE

CBJTYPE

P_GROUP
ACTVT

TTYPE

MA
01, 02, 03

$TWP,

ZODI _LKM P
CKG,

ZODI _RKM P
CKG

Z3SSXRFC,
ZOoDl _FGR
ZODl_FGR P
ROD,

ZODl _LKM P
CKG,

ZODl _RKM P
CKG,

ZODl _MVBG

DEVC, FUGR,
PROG, MSAG

01, 03

DTRA, TASK

NR

03 (NR)

A.3 Authorizations Required for RKM SAP ERP Execution

The following SAP authorizations are required for reverse engineering the SAP

models using RKM SAP ERP.
Object Field Name  Value (4.6¢c) Value (4.7) Value (ECC  Value (ECC
5) 6)
S RFC ACTVT 16
RFC_NAME RFC1, SDI F, SDI FRUNTI M SDI FRUNTI M SDI FRUNTI M
SYST, zODI _  E, E, E,
FGR SDI F(NR) SDI F(NR) SDI F(NR)
RFC_TYPE FUGR
S TCODE TCD SU53
S TABU DI'S ACTVT 03
DI CBERCLS *(G ve
aut hori zat
ions to
tabl e)
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A.4 Authorizations Required for LKM SAP ERP Upload (Background

mode)

The following SAP authorizations are required for running mappings using the SAP

ERP LKMs in a SAP development environment when LKM option
BACKGROUND_PROCESSI NGis set to t r ue (recommended default).

Note:

Developer Key is required in this authorization.

Object Field Name

Value (4.6¢c) Value (4.7)

5)

Value (ECC

Value (ECC
6)

S_RFC ACTVT

RFC_NAVE

RFC_TYPE
S_TCODE TCD
S_BTCH ADM BTCADM N
S BTCH JOB JOBACTI ON
JOBGROUP
S CTS ADM  CTS_ADMFCT
S DATASET  ACTVT

FI LENAME

PROGRAM

16

RFC1, SDI FRUNTI M SDI FRUNTI M SDI FRUNTI M

SDI F, E, SDIF
SLST, (NR) (NR)
SYST,

ZODI *,

ZOoDl _FGR

ZODl_FGR P

FUGR
SU53 SE38 SE38
Y

RELE

TABL
06, 33, 34

\

\10. 30. 0. 2
01\ ODI _SAP
TEST

\ ZODI *,

\

\ HYPTESTO1
\ sapmmt
\trans
\actl og

\ RH5*

SAPLSLGG,
SAPLSTRF,
SAPLZODI *,
ZODl *

A-4 Getting Started with SAP ABAP ERP Adapter for Oracle Data Integrator

E, SDF

E, SDIF
(NR)

NR



Authorizations Required for LKM SAP ERP Execution (Background mode)

Object Field Name  Value (4.6¢c) Value (4.7) Value (ECC  Value (ECC
5) 6)
S DEVELOP  ACTVI 01 02,03,06,1 02,03,06,1
6 6
DEVCLASS
OBJNANMVE ZODl _FGR P
ROD*
OBJTYPE FUCGR PROG
P_GROUP
S _PROGRAM  ACTVT 06
ALG OBJ ZODl _APPOB
J
ALG SUBOBJ ZzCDI _SUBCB
J
S _PROGRAM  P_ACTI ON NR EDI T, NR
SUBM T,
VARI ANT
P_GROUP NR NR
S _TRANSPRT ACTVI 01, 02, 03 03 (NR)
TTYPE DTRA, TASK

A.5 Authorizations Required for LKM SAP ERP Execution (Background

mode)

The following SAP authorizations are required for running mappings using the SAP
ERP LKMs in a SAP production environment when LKM option
BACKGROUND_PROCESSI NGis set to t r ue (recommended default).

Object Field Name  Value (4.6¢c) Value (4.7) Value (ECC  Value (ECC
5) 6)
S RFC ACTVT 16
RFC_NAME RFC1, SLST SLST SLST
SDI FRUNTI M
E, SYST,
ZODl _FGR P
ROD*
RFC_TYPE FUGR
S_TCODE TCD SU53
S _BTCH ADM BTCADM N Y
S BTCH JOB JOBACTION RELE
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Object Field Name

Value (4.6c) Value (4.7)

Value (ECC
5)

Value (ECC
6)

JOBGROUP
S DATASET  ACTVI

FI LENAME

PROGRAM

S APPL_LOG ACTVT

ALG OBJECT

ALG_SUBOBJ

06, 33, 34

\

\10. 30. 0. 2
14\ ODI _SAP
TEST

\ ZODI *,

\

\ HYPTESTO1
\ sapmmt
\trans
\actl og

\ RH5*

SAPLSLGG,
SAPLSTRF,
SAPLZOD! *,
ZCODl *

( SAPLSLOG,
SAPLSTRF,
SAPLZODI *)
NR

06

ZODI _APPOB
J

ZODI _SUBOB
J

( SAPLSLOG,
SAPLSTRF,
SAPLZODI *)
NR

( SAPLSLOG,
SAPLSTRF,
SAPLZODI *)
NR

A.6 Authorizations Required for LKM SAP ERP Upload (Dialog mode)

The following SAP authorizations are required for running mappings using the SAP
ERP LKMs in a SAP development environment when LKM option

BACKGROUND_PROCESSI NGis set to f al se (non-default).

Note:

Developer Key is required in this authorization.

Object Field Name

Value (4.6¢c) Value (4.7)

Value (ECC
5)

Value (ECC
6)

ACTVT

RFC_NAME

RFC _TYPE

16

RFCL,

SDI F,

SYST,

ZODl _FGR,
ZODI_FGR P
ROD*

E, SDI F(NR)
, SYSU

FUGR
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Object Field Name  Value (4.6¢c) Value (4.7) Value (ECC  Value (ECC
5) 6)
S_TCODE TCD SU53, SE38
S _DATASET  ACTVI 06, 33, 34
FI LENAME \
\'10.30.0.2
01\ ODI _SAP
TEST
\ ZCDI *,
\
\ HYPTESTO1
\ sapmmt
\trans
\actl og
\ RH5*,
D:\usr\sap
\ eq5\ DVEBM
GS10\ wor k
\ ZODI *
PROGRAM SAPLSLGG, ZCODl * (NR)
SAPLSTRF,
SAPLZODI *,
ZODl *
S DEVELOP  ACTVI 01 02, 03, 06 02, 03, 06
DEVCLASS ZODl _LKM P
CKG
OBJNANMVE ZODl _FGR P
ROD*
OBJTYPE FUGR PROG
P_GROUP
S_PROGRAM  P_ACTI ON NR EDI T, ED T, NR
SUBM T, SUBM T,
VARI ANT VARI ANT
P_GROUP NR
S CTS_ADM  CTS_ADMFCT TABL
S _TRANSPRT ACTVI 01
TTYPE DTRA, TASK

A.7 Authorizations Required for LKM SAP ERP Execution (Dialog mode)

The following SAP authorizations are required for running mappings using the SAP
ERP LKMs in a SAP production environment when LKM option

BACKGROUND_PROCESSI NGis set to f al se (non-default).
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Object Field Name

Value (4.6c)

Value (4.7)

Value (ECC
5)

Value (ECC
6)

S _RFC ACTVT

RFC_NAME

RFC_TYPE
S_TCODE TCD
S _DATASET  ACTVT

FI LENAME

PROGRAM

16

RFCL,
SDI F,

SYST,
ZODl_FGR,
ZODI_FGR P
ROD*

FUGR
SUS3
06, 33, 34

G \usr\sap
\ RH5\ DVEBM
GS30\ wor k
\z*,

\
\10.30.0.2
14\ ODI _SAP
TEST\ z*,

\

\ HYPTESTO01
\ sapmt
\trans
\actl og

\ RH5*

SAPLSLOG,
SAPLSTRF*,
SAPLZODI *

SDI FRUNTI M SDI FRUNTI M SDI FRUNTI M

E, SDIF
(NR)

E, SDIF
(NR)

E, SDIF
(NR)
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SAP Stand-Alone Connection Test

This appendix describes how to perform an SAP stand-alone connection test.

In addition to the Connection Testing described above, a test can be performed outside
of ODI using a standalone java utility.

SAP Stand-Alone Connection Test

B.1 SAP Stand-Alone Connection Test

To use a standalone java utility to test the connection:

1. Open a command window.
2. Change to <CDI _HOME>/ odi / sdk/ | i b directory.
3. Make sure that JAVA_HOME points to a JVM (at least 1.5).

4. Make sure that you have installed SAP Java Connector and that the sapj co3. j ar
and the sapjco3 library are in the <ODI _HOVE>/ odi / sdk/ | i b directory.

5. Launch the utility using the following command:

On Windows:

java -cp sapjco3.jar;odi-sap.jar
oracl e. odi . sap. kmtest. JCoTest

On Linux/UNIX:

java -cp sapjco3.jar:odi-sap.jar
oracl e. odi . sap. kmtest. JCoTest

This should result in an output similar to this:

10MH: Cannsct Eo
Application Sard

unknown

tByMame: “<EAP fApplication Server?® not Found
1F o

6. Use a text editor to open the ODI _SAP_CON_PQOQL. j coDest i nat i on file in the
oracl edi / dri ver s directory. The file should look like this:

#for tests only!
jco.client.lang=EN

SAP Stand-Alone Connection Test B-1




SAP Stand-Alone Connection Test

jco.destination.peak_|init=10
jco.client.client=800
jco.client.passwd=<SAP Passwor d>
jco.client.user=<SAP User>
jco.client.sysnr=00

jco.destination.pool _capacity=5
jco.client.ashost=<SAP Application Server>

7. Enter your SAP connection information, which you have received from your SAP
administrator. The file will then look similar to this (use your connection
information!):

#for tests only !
jco.client.lang=EN
jco.destination.peak_limt=10
jco.client.client=800
jco.client.passwd=0DI 123
jco.client.user=0Dl
jco.client.sysnr=00

j co. destination.pool _capacity=5
jco.client.ashost=123.123. 123. 123.

8. Launch the utility again using the following command:

On Windows:

java -cp sapjco3.jar;odi-sap.jar
oracl e. odi . sap. kmtest. JCoTest

On Linux/UNIX:

java -cp sapjco3.jar:odi-sap.jar
oracl e. odi . sap. km test. JCoTest

This should result in an output similar to this:
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a —e¢p odi-zap.jar;zapjecod.jar oracle.odi. zap.kn.test. JCoTest

QDI _SAP_CON_FOOL

1188
1508857 _1
iso-B8%7-1

In addition to just testing the SAP connection, the utility will also validate the
existence of certain Function Modules required for the RKM. These are installed
during first execution of the RKM (UPLOAD_ABAP_CODE and UPLOAD_ABAP_BASE
settotrue).

9. Delete the ODI _SAP_CON PQOQL. j coDest i nat i on file after execution, as it
contains the SAP login credentials.
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Uninstalling ODI SAP Components

This appendix describes how to uninstall ODI components from your SAP system.

For removing ODI connectivity from the SAP system, please follow the steps
described in this section.

Please note that this will delete ALL components including generated extractor
programs.

Updating ODI SAP Components
Uninstalling ODI SAP Components

C.1 Updating ODI SAP Components

During first-time installation the RKM installs some ODI objects into the SAP system.
This installation consists of two parts: some base objects and some RFCs. When the
RKM options UPLOAD_ABAP_BASE and UPLOAD_ABAP_CQODE are both setto t r ue,
the base objects and the RFCs are installed. Such full installation requires that no ODI
SAP objects are installed in the SAP system. See Uninstalling ODI SAP Components if
needed.

If the ODI objects installed into your SAP systems have been installed by RKM SAP
ERP v34 or later / RKM SAP BW v25 or later, there is no need for reinstalling the base
objects and it is sufficient to update just the RFCs. Reinstalling the RFCs is achieved by
executing a reverse engineering run with RKM option UPLOAD_ABAP_BASE set to

f al se and RKM option UPLOAD_ABAP_CCDE set to t r ue.

C.2 Uninstalling ODI SAP Components

To upgrade to a newer ODI SAP Connector release or to permanently remove the ODI
connectivity:

1. Start the SAP GUL

2. Connect to the SAP systems you want to uninstall.

3. Go to the transaction SE80.

4. Select the package or development class option from the drop down box.

5. Enter ZODI _RKM _PCKGin the package or development class field. Note that for
older installations the package name is ZODl _ DEVCLASS.

6. Right-click the ZODI _RKM PCKG object below the object name tab.

7. Select Delete in the drop down menu and delete the development class.
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If it does not allow deleting the development class individually, delete all the
objects inside one by one. For the contained Function Group please make sure to
delete it in one go and do not delete the Function Group's Function Modules
individually. Once all objects have been removed, delete the development class
itself.

8. Go to transaction SE10. Select Modifiable and Workbench Requests. Click
Display.

9. Select the transport requests which have the ODI Objects and Release them.
10. Now repeat the steps 3 to 7 to delete Development Class.

11. Go to transaction SEOQ1. Select Modifiable and Workbench Requests. Click
Display. Release the Transport Request which has ZCDI _ RKM_PCKG

12. Repeat Step 4 to 11 for package ZODI _LKM PCKG
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